




	


Creating a Resume 
For most airlines, applications are completed online and may or may not request that your resume be included. Your resume largely determines whether you will be invited to (or back to) an interview. We recommend that each time you contact an airline employment office for the first time, you include a resume (and cover letter) - unless the company has a specific initial contact procedure. This means that you should always include a resume even if the airline does not require one. Then, after completing the online application, the resume (and cover letter) should be submitted once again. Basically, any correspondence you send to an airline before the interview should include a cover letter, a resume and your application. Most applications will have an area where you can upload your attachments.
The resume itself may seem simple enough, but most people overlook many of the finer points of resume writing, which can mean the difference between getting an interview and not getting an interview. With the advent of the Applicant Tracking System (ATS), your resume may not even be read by a human. Because of the thousands of resumes received by airlines, the ATS system allows a computer to scan your resume looking for keywords that will move your resume to the proper pile. At that point, a recruiter may intervene and read the resume. Some examples of ATS keywords the computer will look for on your resume are “customer service,” “communication and interpersonal skills,” and “worked independently.”
Your resume is a statement about you. If it is poorly written with misspellings and/or improper English, this reflects on your professionalism and attention to detail. The resume should be an impeccable piece of work presenting your professional qualities. 
Here are some very important guidelines you should follow when creating your resume:
· Choose at least 3 qualities that correspond to the duties of a flight attendant and draw attention to these qualities in your work history or skills section. Review and relate your own qualities that correspond to performing these duties. Use action verbs like trained, supervised, and organized, etc. when describing your duties.
· Airlines seek applicants who possess certain qualities that make them ideally suited for a flight attendant career. Knowledge of these qualities will make it easier for you to compose your resume and complete your application, as well as interview more successfully. Use or relate to these terms as much as possible in your resume, on your application, and during your interview(s):

* Friendly * Flexible * Mature * Outgoing * Loyal * Eloquent * Patient * Sensitive * Tactful * Honest * Poised * Decisive * Motivated * Neat * Energetic * Aware * Punctual * Responsible * Adaptable * Dependable * Intelligent*
· Do not be humble about your accomplishments. Do not be afraid to showcase your talents. If you feel that your accomplishments are relevant to the job, include them in your resume. However, DO NOT LIE! If you alter the truth to make yourself look better, it could be discovered later during the background check and you will be disqualified. Or worse, if it is discovered after you have been hired, you will be fired!
· Use a professional resume format. The presentation of your resume is important. Although many books have been written about resume writing, and there are many templates offered online, we recommend a specific format which lends itself well to the flight attendant position and ATS. Our recommended flight attendant format is a single-column format that allows for maximum use of space. This format also converts easily to plain text (ASCII) for use in email applications (discussed later in this section). We use a Calibri font with an 11- or 12-point font size (Macintosh: 12 point); section titles are in bold face and are underlined; bullets are used to identify items in a list. Here's a short sample:
  
	ACTIVITIES AND INTERESTS
· Volunteer worker, Catholic Charities Food Pantry, Lowell, MA
· Participant, Boston Marathon, 2001, Boston, MA
· Fund-raiser, Dana Farber Cancer Institute, Boston, MA


Now let’s look at the sample resume you downloaded. If you haven’t downloaded it yet, do so now. You can then print it out and refer to it for this discussion.
IMPORTANT - The formatted resume will open in Microsoft Word (if you have it installed on your computer) and you can later use this template to plug-in your own information. For now, you should refer to it as we explain how to compose your resume. When you have completed this section, begin entering your own data in place of the existing data (just highlight the text you are replacing and type over it; that way, all formatting will be retained), save the new resume, and follow the guidelines in this section to proofread and print it.
4. HEADER
The header should include your name, address, and primary contact phone number. We do not recommend listing your work phone, unless it is your only telephone contact number. If you have an email address, you may also include that here. If you have a LinkedIn account, be sure to include it here as well. Just be sure that all the information matches what you have on your resume.
NOTE: Make sure the telephone contact number you give in your header has some form of voicemail. Also, make sure the message the caller hears is very professional and business-like. During the airline application process, there is no place for "cute" messages. 
If you have an outdated email account, this is a good time to change it. For more information on this, visit our November 29, 2018 blog post entitled, “Is Your Email Address Hurting Your Job Search?”
4. OBJECTIVE or SUMMARY
Individuals with no prior flight attendant experience should use an “Objective” as a header. Experienced flight attendants should use a “Summary.” 
The objective should be brief and to the point and explain why you are qualified for the job. The objective gives you an opportunity to tie together several of your strengths. The objective should be customized for each airline you are applying to. 
Here is an example of an objective:
		OBJECTIVE
		Friendly and responsible customer service manager for large healthcare company. 			Obtained highest regional client satisfaction scores (98.9%). Seeking to enliven my 			passion for travel, exceptional customer service and second language skills by growing 			with the team at American Airlines.
Here is an example of a summary:
		SUMMARY
		Friendly and responsible flight attendant with 15+ years expertise on domestic and 			international commercial flights. Proficient in emergency situations, fully trained in CPR 			and AED, as well as diffusing situations from reaching dangerous levels. Seeking to 			advance my career by growing with the American Airlines family.
4. PROFESSIONAL EXPERIENCE

You should list your past 3 employers, listing the most recent first. If you were self-employed, list that here as well. If you have more than 3 previous employers, include the ones that show customer service experience. Also, be sure to account for any gaps in your employment history. In this section you should try to relate each position held with the duties and responsibilities and desirable qualities of a flight attendant. 
Do not use any first-person pronouns. Rather than saying, "I educate HMO members on health plan benefits," use concise, incomplete sentences, such as, "Educate HMO members on health plan benefits." Use plenty of action verbs in this section. Also, use present tense if you are still at your current employer and past tense if you are referring to a previously held position. In our entry level sample resume, we use 11 action verbs that relate directly to the flight attendant position:
  
	Educate
Supervise
Analyze
Train
Worked
Managed
	Traveled
Coordinated
Communicated
Solved
Screened


[bookmark: _GoBack] 
NOTE: For months of the year, it is preferable to spell out the full name of the month rather than listing a number, using “to” rather than a hyphen when spelling out these dates. If you have space constraints, you can list as follows:  Months with four or fewer letters, e.g. May, June, and July are not abbreviated, the remaining months Jan., Feb., Mar., Apr., Aug., Sept., Oct., Nov. and Dec. are abbreviated. Alternatively, you can just list the month and date numerically. Be sure to use four digits for the year. Here are some examples in order of preference:
1. September 1999 to May 2003 
2. Sep 1999 – May 2003 
3. 9/1999 – 5/2003
4. EDUCATION
List your education history in reverse chronological order (i.e., start with most recent and work your way backwards). If courses taken are relevant to the flight attendant position, they should be listed here. If you are a recent college graduate with very little real-world work experience, list the "Education" section before the section on "Experience."
The following sections of your resume are optional and should be tailored to your own situation. Since the section titles that we use in our sample resume may not apply to you, you can change them accordingly. For example, if you have traveled extensively, you may want to include a section on "Travel" or "Travel Experience." Other section possibilities include "Personal Qualities," "Language Skills," "Volunteer Work," etc. Whatever you include, make sure it is relevant to the flight attendant position and try to stay within the 1-page resume limit.
4. SKILLS AND TECHNICAL TRAINING
In this section, you should list additional training you have received, especially if it relates directly to the flight attendant position. Items to consider listing here include CPR training, acting classes, pilot training, language classes, scuba certification, college extension courses (non-degree), etc.
4. 
4. 
4. HONORS AND AWARDS
List any honors or awards received both at school and at work. If you graduated with honors, list it here along with your G.P.A. Only include your G.P.A if it was extremely high (above 3.5).
4. ACTIVITIES AND INTERESTS
Any volunteer work you have participated in along with your interests and hobbies should be listed here. 
NOTE: Several years ago, it was appropriate to include a section entitled, Personal or Personal Data, featuring your height, weight, age, etc. Due to the increase in discrimination lawsuits over the years, this section is no longer necessary nor appropriate. Along the same line, it is no longer appropriate to include references or “References on Request.”

Here are several more important guidelines you should follow when creating your resume: 
· Keep your resume to 1 page. If your resume is over 1 page, very often it won't be read - or worse, the second page will be misplaced. Be concise and keep it short. Compose your resume on a computer using Microsoft Word or a comparable word processing application. If you find that your resume exceeds the 1-page recommended limit, try experimenting with different fonts and point sizes, but do not make it so small that it is difficult to read! Generally, 10 point is the smallest point size you should consider. If font and font size changes do not help, you can also reduce the size of your margins to get more text on the page. Conversely, if you find that your resume does not completely fill a page, you can increase the font size and/or page margins. 
· Spell-check and grammar-check your resume! You would be amazed how many resumes are submitted with spelling and grammatical errors. Such errors will give your resume a very unprofessional appearance and make you out to be a very sloppy and/or ignorant individual - not exactly the qualities airlines are looking for. Fortunately, most word processing applications have built-in spelling and grammar checkers for your convenience. But they are not fool-proof, so you (and at least 1 other person) should proofread your resume. A good trick used by professional proofreaders for accurate spell-checking is to read each line of text backwards from end to beginning. This way, you are not reading groups of words, but rather verifying the spelling of specific words. When checking grammar, obviously read sentences from beginning to end. The easiest method, of course, is to use the built-in spell and grammar checker that comes with Microsoft Word.
· Use plain white, 24lb. bond paper. This not only creates a professional presentation, but the rigidity of the paper makes for easier reading; lightweight paper is harder to handle and wrinkles easily. Do not use fancy colored paper when presenting your resume; airlines are more interested in content than artwork and it won’t get you to the top of the resume pile any faster.
· Limit your font style, font size, and use of boldface type. In our sample resume, we use 1 font (Times Roman) and an 11-point font size, except for the header. Any more than a single font and point size and your resume will become unnecessarily cluttered and hard to read. Use of boldface type should also be kept to a minimum. Whatever you do, DO NOT use boldface type or all caps to emphasize anything within a sentence (e.g., provide international support as a French language speaker). Bold face and caps should be reserved for section titles only. If you follow our resume template precisely, you will stay out of trouble.
· Print your resume in black ink, preferably on a laser printer or ink-jet printer. If you do not own a high-quality printer that can print at least 300 dpi (dots per inch), compose the resume on your computer, save it to a flash drive, or email it to have it output at a local print shop, like Kinkos or Staples. Also, be sure to use only black ink - and do not even think about submitting a hand-written resume!
· Always make several copies of your resume and carry them with you to all interviews. Very often interviewers will request additional copies of your resume, so always carry extras. Plus, sometimes you will be required to complete an employment application immediately following an interview. During these instances, having an extra copy of your resume will be especially critical, since dates, employment history, education, etc. can be quickly transferred from your resume to the application.
[bookmark: online_resumes] Online Resumes 
With the ubiquity of computers today, electronic resume submission is a popular method of accelerating the application process. Most airlines accept online resumes in text format. If you have a choice, submit both a hard copy and an online resume, but make sure you follow the electronic resume guidelines below. Although your resume may appear to be in a perfect "email-ready" format, quite often an email recipient will see something entirely different. Without the proper formatting (described below), excess spacing and line-breaks can wreak havoc on your email resume, making you look very unprofessional. Additionally, the ATS system is very picky about what it sees on the text version of your resume. Speaking of sending your resume online, pay close attention to the attachment format requested by the airline. Types of attachments are DOC or DOCX (Word), PDF and ASCII (text). The types of attachments we recommend you send are DOC or DOCX, and ASCII. PDF documents sometimes cannot be read by the ATS computers and as a result, will be discarded. If the application specifically says it accepts PDFs, then you might be OK to send it along in that format, but we still discourage it.
Some airlines will ask for email resumes in ASCII format. ASCII, which stands for American Standard Code for Information Exchange, and is synonymous with "plain-text." Some applications will ask that you paste your resume into a text box, but you will need to follow the procedures below before you do so.

An ASCII resume can be read by virtually any computer in the world. However, when you convert your resume to plain-text (ASCII), all formatting is lost. No longer will there be bold, underlined or italicized subheads. Bullets will also be lost. Basically, anything you are not able to type on a standard keyboard will be gone. This is the price you pay for compatibility.
  
Besides converting your resume to plain-text format, there are many more steps involved in creating an email resume.  
Follow these step-by-step guidelines to create your email resume:
1. Compose your resume in a word processor, preferably Microsoft Word.
2. Format the entire document exactly as follows:
· Set left and right margins to 1" (6 1/2" width). In Microsoft Word, select Layout from the File menu. Then click on the Margins tab to set your left and right margins to 1".
· Select all the text. In Microsoft Word, from the Edit menu, choose Select All.
· Change font to Courier or any other non-proportional, fixed-width font.
· Change point size to 12.
· Use "Save As..." to save your resume as "Text Only with Line Breaks."
3. Launch your text editor (Notepad for Windows or SimpleText for Mac).
4. From the text editor's File menu, choose Open. Then locate and open your file (if Notepad or SimpleText is your default text editor, you can double-click on the .txt file to launch the editor and open the file in one step).
5. View the file within the text editor. This is exactly how your email resume will look to recipients, so you will want to clean it up. Begin by replacing all unsupported characters with their ASCII equivalent. For example, in certain versions of Microsoft Word, bullets appear as question marks. You should replace these with asterisks or hyphens. How do you know if a character is an ASCII-equivalent character? All keyboard characters are safe to use.
You also may notice some undesirable line-breaks before the ends of sentences. This is because the width of each line is limited to 65 characters for compatibility with most email programs. You can try to fix these formatting problems by making the line-break come earlier but be sure not to exceed the 65-character limit by extending the line. 
6. Once you are happy with the appearance of your resume, save it, choose Select All from the Edit menu, and copy it to the clipboard.
7. Open your email program and compose a new email message using yourself as the recipient. In the body of the message paste the copied version of your resume and send it to yourself.
8. When you receive your resume via email, look it over carefully. This is exactly how your resume will look to recipients. If there are still spacing or layout errors, go back to the saved version of your resume in the text editor and make the necessary changes. Your work is not complete until you successfully send yourself (and a friend) the email resume properly formatted.
9. You now have a perfectly formatted resume to email to the airlines. Be sure to make your cover letter email-safe as well; never send an email resume without a cover letter pasted above it in the body of the message.
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Faxing Your Resume 
Many airlines will allow you to submit your resume using a fax machine or fax modem. While faxing a resume is fast (it gets there instantly), there are quality control issues. After you have spent countless hours fine-tuning your resume to create a professional look and feel, your recipient might end up with a resume with a black streak down the middle of the page, perhaps with many words blurred or illegible. And, unfortunately, the airlines usually won't call you to request another; they will just push it aside and move on to the next one in the pile.
As a result, we do not recommend faxing your resume unless it is necessary. But if you must fax your resume (and cover letter), immediately follow-up with a hard copy in the mail (with a note attached, stating that the resume was previously faxed). The best method for faxing your resume is to use a fax cover sheet that lists your name, phone number, and number of pages sent, asking the recipient to call you back if the documents were not received completely and without errors. You should also take the proactive approach and call the office yourself for verification.
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Creating a Cover Letter 
You should always include a cover letter with your resume, application or any other correspondence directed to an airline. Some recruiters admit that they do not even read resumes without a cover letter!
A cover letter is extremely important. It not only allows you to communicate directly with the person or department that does the hiring, but also allows you to showcase your talents in a more concise manner than on the resume. Plus, it gives you the opportunity to make a first impression with the reader before your resume is even read. Many people make the mistake of not including a cover letter or include one that is poorly written.
There are several key components to a powerful cover letter. Your cover letter should communicate:
· Your desire to become a flight attendant.
· How you view the job as a career position.
· Your qualifications (a brief overview).
· Why you would be an asset to the company.
· Your personal traits that relate to the flight attendant position.
· Your gratitude for the opportunity, marked by a closing "thank you."
The cover letter should be addressed (ideally) to a specific person in the hiring department. If you are unable to obtain the name of a person, you should use the generic, "To whom it may concern" or "Dear Sir or Madam." Make sure you date the cover letter and sign it. Since the cover letter will usually accompany your resume, use the "enclosure(s)" footer at the bottom of the page. 
Other cover letter hints:
· Use the same paper, ink, and print quality as your resume.
· Ensure that your return address information is printed at the top of the letter.
· Download our Entry Level Flight Attendant Cover Letter (if you haven’t already done so) to compose your cover letter.
· When sending your cover letter as part of an email message, convert it to ASCII format first, just as you did the resume 
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